Table of Contents

Contents

Term Structure ................................................................................................................................ 2
Internet Native Banner (INB) and Self Service Banner (SSB) ......................................................... 2
Banner and Aurora .......................................................................................................................... 2
Security ........................................................................................................................................... 2
Logging in to Banner .................................................................................................................... 2
Banner Main Menu ........................................................................................................................ 3
Toolbar and Menus ......................................................................................................................... 6
Working Within a Form ................................................................................................................... 7
Searches and Queries ..................................................................................................................... 8
Find a Student ............................................................................................................................... 10
Logging Out of Banner .................................................................................................................. 13
Menus and Buttons ....................................................................................................................... 13
**Term Structure**

There are three terms per year: Fall, Winter, and Summer

- Fall 201X90 (201390)
- Winter 201X10 (201410)
- Summer 201X50 (201450)

Part of Term will further differentiate the time period within a given term. For example:

- Standard 1 (Fall or Winter)
- Fall/Winter Part A F1
- Fall/Winter Part B W1
- May Day P1
- June Day P2

**Internet Native Banner (INB) and Self Service Banner (SSB)**

In **INB** you view the information in forms and tables. **SSB** is a web based application that allows you to view the same information in a more intuitive, user friendly format. However, more detailed information is available in INB than in SSB.

**Banner and Aurora**

**Banner** is the name of the information system purchased by the University of Manitoba. **Aurora** is the implementation of Banner at the University of Manitoba. This encompasses how Banner was configured and customized to meet the University’s needs and third party software that is used with Banner, such as OCAS (for Admissions).

**Security**

- Your job functions will determine your security profile and access.
- Your security profile will give you access to different forms based on your job.

**Logging in to Banner**

- From the U of M home page, go to the **Faculty & Staff** tab and under **Online Services**, select **Aurora INB**. This will take you to the INB Login. You may first be prompted with a Security Warning message asking if you wish to view only the webpage content that was delivered securely, select NO.
- Alternatively, type the following URL directly into your browser: [http://banner.cc.umanitoba.ca](http://banner.cc.umanitoba.ca). You should bookmark this URL.
• The Logon screen will display:

![Logon Screen](image)

• Enter your User ID and password.
• Click Connect.

**Note:** Banner 8.5 requires the **Java 7 Runtime**, though you should avoid **Java 7.51** as Banner is not currently compatible with this version. (A prompt to install Java should appear automatically when you attempt to open Banner for the first time). If you experience difficulty, contact your technical support person.

**Banner Main Menu**

The Main Menu has a hierarchical structure, containing resources for various areas using Banner (ie. Student, Finance). All **Banner Student** resources are found within the **Student [*STUDENT]** menu.

There is an acronym associated with every menu, form and process in Banner.

**Menus** are characterized by an asterisk (*) beside the acronym, while **forms** contain no asterisk.

The right-hand side of this page contains a series of useful links.
• To open an item (menu or form), double-click on the icon or the item name. Opening a menu item will reveal a list of options available within that menu.
• To close an item, double-click on the icon or the item name.

Form names (acronyms):

- Seven letters: SCACRSE
- Letter one: S is for Student
- Letter two: C is for Catalogue
- Letter three: A is for Application
- Four letter code: CRSE is for Course

Direct Access Field - To avoid having to navigate through menus, you can enter the acronym of the form you wish to access:
Note: The Direct Access field is one of the only places in Banner where you must use the Enter key. A common mistake made with the Direct Access field is to select the icon beside it. If this occurs, the following window will appear:

- Click on the Cancel button at the bottom of the window, and you will be returned to the Direct Access field.
- Use the up and down cursor keys to scroll through your recently used forms.
Toolbar and Menus

**Menu Bar**

**Horizontal Toolbar**

**Title Bar**

**Autohint Line**

**Title Bar** - provides the name and acronym of the form or window you are currently working in.

**Autohint Line** - contains information for the field where the cursor is located. This is a very helpful feature in Banner, as it will provide error messages and can help you when you’re unable to proceed or are unsure of what to do next.

**Horizontal Toolbar** - contains iconic buttons which can be used for performing common functions - e.g., **Save**, **Next Block**, **Exit** (see next page). Note that the name of the icon will appear when you pass your mouse over it.

See page 15 for an explanation of the menus and buttons.
Working Within a Form

A Banner form is divided into several sections:

**Block:** You move from one block of information to the next within a form. A *block* is a section of a form containing related information. If a form consists of more than one block, each block is separated from the other with a line or is in a separate box. Most forms have one or two types of blocks:

- **Key block** - the first block in a form, containing key information such as a term, id, or CRN

- **Information block** - contains additional information pertaining to key information.

- To move from the key block to an information block, or from one information block to another, click on the next block icon, or Ctrl + Page Down using the keyboard.

From the information block you can also click on the tabs across the top of the information block. If a tab is grayed out it means it is not accessible.
**Field**: An area on a form where you can enter, query, change or display specific information.
To move around the forms:

- Fields – Tab/Shift+Tab
- Blocks – Next Block/Previous Block
  - Ctrl+PageDown/Ctrl+PageUp
- Records – Next Record/Previous Record
  - Up and Down arrows
- Return to Key Block – Rollback/Shift+F7
- Options Menu
  - Blocks
  - Forms
- X or Ctrl + Q to close a form

**Searches and Queries**

**Field Search**
This function is available for specific fields where there is one or more Banner table(s) that can provide the data required for the field. You know a field search is available when one of the following two indicators exist:

[Search icon] Always located beside a field that can be populated with information. Select the icon to pull up a form or window where you can search for a value or information related to the field.

**Note:**
If an Option List window appears after selecting the **Search** icon, select the appropriate table to query by clicking on it with your mouse once only.

**LOV (List of Values)**: When a field has the [ ] next to it, an LOV is attached. Single-click in the field you want to enter into and then on the icon to pull up a table of values that can be used to populate the field, or go to the **Help** menu and select **List** to retrieve the list.

**Record Search**
Searching for different types of records uses different forms. The search forms available allow you to search based on a variety of fields. There are several tools that can be used when searching a form for a record:

[Enter Query] - clears a search form of data in order to enter search criteria to narrow down your search.
- **Execute Query** pulls up records into the search form. If you entered search criteria to narrow your search, only those records that meet the criteria will appear.

- **Cancel Query** cancels the query and takes you right out of the form you are in.

**Fetch Next Set** - Select from the **Query** menu to replace the current set of displayed records with the next set of records. This is useful when there are a large number of records returned for your query.

**Last Criteria** - Select from the **Query** menu to re-enter the criteria from your last search and change if needed - only works when you’ve put the form in Query mode.

**Wildcards** - Oracle wildcards can be used to limit your search. There are two wildcards that can be used: % and _.

The character % represents any number of unspecified characters. The character _ represents one occurrence of an unspecified character.

**Examples:**

<table>
<thead>
<tr>
<th>To get these results:</th>
<th>Enter this criteria:</th>
</tr>
</thead>
<tbody>
<tr>
<td>All records that contain “Manitoba”</td>
<td>%Manitoba%</td>
</tr>
<tr>
<td>All records that begin with “Manitoba”</td>
<td>Manitoba%</td>
</tr>
<tr>
<td>All records that end in “Manitoba”</td>
<td>%Manitoba</td>
</tr>
<tr>
<td>All records that begin with “Ma” and end in “itoba”</td>
<td>Ma_itoba%</td>
</tr>
</tbody>
</table>
Find a Student

Everyone at the University of Manitoba is a General Person including:

- Students, Faculty, Staff, Vendors

Non-Persons are companies, government agencies, etc.

- Use the SPAIDEN form to find General Person records.
- If you have the ID of the person you are looking for, enter it in the ID field.
- If you don’t have the ID, click on the search icon to search by first and last name.
- Select Person Search from the Option List to open the Person Search (SOAIDEN) form.
You may search or execute this query by:

Press F8, From the toolbar Query/Execute, Select the Execute Query icon

The format for all person searches is: Last name, First Name

Examples:

1. Smith, J% --This will return all ID’s with last names of “Smith” and first names beginning with “J”

2. Mag%, P% --This will return all ID’s with last names staring with “Mag” and first names starting with “P”

3. %, Barbara --This will return all ID’s with the first name “Barbara”

4. M%vish --This will return all ID’s with the name having a first initial “M”, ending with “vish” and having anything in between

5. Smith, Carol --This will return all ID’s with the last name of “Smith” and the first name of “Carol”.

11
To clear a field when searching, select Query/Enter.

How to determine which of the people in the list is the person you are looking for?

- Use the birth date, address, and other demographical information to match the person.
- Double-click in the **ID field** to get more information on the person.

The **Current Identification form** will open. Next block/Ctrl + Page Down to populate the fields. Next block or Tab to move to the various tabs.
Logging Out of Banner

- Click on the black ‘X’ on the horizontal tool bar to close Banner.

- You will be asked if you want to exit this Banner session, respond ‘Yes’.

Please do not close your browser to log out of Banner. Always use the “X” on the toolbar to log out.

Menus and Buttons

See pages 14 - 17.
## Pull-Down Menus

There are nine pull-down menus on the menu bar, each with a variety of selections. A dimmed option on a pull-down menu means that the option is disabled.

### File Menu

<table>
<thead>
<tr>
<th>Option</th>
<th>Toolbar Icon</th>
<th>Keyboard Shortcut</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Direct Access</td>
<td></td>
<td>F5</td>
<td>Accesses the Direct Access Form – GUAPARM</td>
</tr>
<tr>
<td>Object Search</td>
<td></td>
<td></td>
<td>Accesses the Object Search Form – GUIOBJJS to locate a form, job, or QuickFlow if you know part of its name, description, or type</td>
</tr>
<tr>
<td>QuickFlow</td>
<td></td>
<td></td>
<td>Displays the QuickFlow Form (GUAQFLW) which is used to access a QuickFlow</td>
</tr>
<tr>
<td>Select</td>
<td></td>
<td>Shift-F3</td>
<td>Returns you to the calling form and enters the selected value into the field that called the form</td>
</tr>
<tr>
<td>Rollback</td>
<td></td>
<td>Shift-F7</td>
<td>Action depends on what type of form is currently used.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Form</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application and Inquiry</td>
<td>Clears all information (except Key information) and returns you to the first enterable field in the Key Block</td>
</tr>
<tr>
<td>Validation</td>
<td>Returns you to the first enterable filed on the form</td>
</tr>
<tr>
<td>Query</td>
<td>Returns you to the first enterable filed on the calling form</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Option</th>
<th>Toolbar Icon</th>
<th>Keyboard Shortcut</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save</td>
<td></td>
<td>F10</td>
<td>Saves all changes entered since the last time you saved</td>
</tr>
<tr>
<td>Refresh</td>
<td></td>
<td></td>
<td>Clears the message line; redraws the screen</td>
</tr>
<tr>
<td>Print</td>
<td></td>
<td></td>
<td>Prints the current window; inputs the date and time in the title bar</td>
</tr>
<tr>
<td>Exit</td>
<td>X</td>
<td></td>
<td>Actions vary.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>If selected from...</th>
<th>Then you...</th>
</tr>
</thead>
<tbody>
<tr>
<td>A form</td>
<td>Exit that form</td>
</tr>
<tr>
<td>The main menu</td>
<td>Exit form Banner</td>
</tr>
<tr>
<td>Query mode</td>
<td>Cancel the query</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Option</th>
<th>Toolbar Icon</th>
<th>Keyboard Shortcut</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exit QuickFlow</td>
<td></td>
<td></td>
<td>Exits you from your QuickFlow</td>
</tr>
<tr>
<td>Preferences</td>
<td></td>
<td></td>
<td>Displays the Personal Preferences Maintenance Form (GUAUPRF) which is used to customize Banner for individual users</td>
</tr>
</tbody>
</table>

14
Edit Menu

<table>
<thead>
<tr>
<th>Option</th>
<th>Toolbar Icon</th>
<th>Keyboard Shortcut</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cut</td>
<td></td>
<td>Ctrl-X</td>
<td>Cuts selected text and places it on the clipboard</td>
</tr>
<tr>
<td>Copy</td>
<td></td>
<td>Ctrl-C</td>
<td>Copies selected text and places it on the clipboard</td>
</tr>
<tr>
<td>Paste</td>
<td></td>
<td>Ctrl-V</td>
<td>Pastes text from the clipboard to the cursor location</td>
</tr>
<tr>
<td>Edit</td>
<td></td>
<td></td>
<td>Displays the editor window which is used to enter and update text</td>
</tr>
</tbody>
</table>

Options Menu

The Options Menu varies from form to form. Some take you to other blocks and windows within the current form, other options take you outside the current form. The Options menu as well as valid File menu options may be accessed at any time by right clicking on a blank section of any form.

Block Menu

The Block Menu enables you to move from one block area to another within a form.

<table>
<thead>
<tr>
<th>Option</th>
<th>Toolbar Icon</th>
<th>Keyboard Shortcut</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Previous</td>
<td></td>
<td>Ctrl-PAGE UP</td>
<td>Moves cursor to the previous block that has at least one enterable field</td>
</tr>
<tr>
<td>Next</td>
<td></td>
<td>Ctrl-PAGE DOWN</td>
<td>Moves cursor to the next block that has at least one enterable field</td>
</tr>
<tr>
<td>Clear</td>
<td></td>
<td>F7</td>
<td>Clears all information in the current block. Also known as Enter Query. Puts the form in Query Mode</td>
</tr>
</tbody>
</table>

Item Menu

The Item Menu enables you to move from one field to another and clear and duplicate data within a form.

<table>
<thead>
<tr>
<th>Option</th>
<th>Toolbar Icon</th>
<th>Keyboard Shortcut</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Previous</td>
<td></td>
<td>Shift-TAB</td>
<td>Moves the cursor to the previous enterable field</td>
</tr>
<tr>
<td>Next</td>
<td></td>
<td>TAB</td>
<td>Moves the cursor to the next enterable field</td>
</tr>
<tr>
<td>Clear</td>
<td></td>
<td></td>
<td>Clears all information from the current field on your display. Does not remove information from any records or tables</td>
</tr>
<tr>
<td>Duplicate</td>
<td></td>
<td></td>
<td>Duplicates the contents of the same field in the previous record and copies it into the new record. Used in blank row of a repeating record</td>
</tr>
</tbody>
</table>
**Record Menu**

The *Record Menu* allows you to work with records within a form.

<table>
<thead>
<tr>
<th>Option</th>
<th>Toolbar Icon</th>
<th>Keyboard Shortcut</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Previous</td>
<td>↑</td>
<td>Up Arrow</td>
<td>Moves cursor to the enterable field in the previous record</td>
</tr>
<tr>
<td>Next</td>
<td>↓</td>
<td>Down Arrow</td>
<td>Moves cursor to the first enterable field in the next record of the current block. If the cursor is in the last record, a new record is created</td>
</tr>
<tr>
<td>Scroll Up</td>
<td></td>
<td>Page Up</td>
<td>Scrolls up the list of repeating records.</td>
</tr>
<tr>
<td>Scroll Down</td>
<td></td>
<td>Page Down</td>
<td>Scrolls down the list of repeating records.</td>
</tr>
<tr>
<td>Clear</td>
<td></td>
<td></td>
<td>Clears all information from the display of the current record</td>
</tr>
<tr>
<td>Remove</td>
<td>←</td>
<td>Shift F6</td>
<td>Removes all information for the current record. When you save the record is permanently deleted</td>
</tr>
<tr>
<td>Insert</td>
<td>+</td>
<td>F6</td>
<td>Inserts a new blank record in the existing records</td>
</tr>
<tr>
<td>Duplicate</td>
<td>≫</td>
<td>F4</td>
<td>Duplicates the content of all fields in a record and copies them into a new record</td>
</tr>
<tr>
<td>Lock</td>
<td></td>
<td></td>
<td>Temporarily locks the contents of the record so no other Banner user can update it.</td>
</tr>
</tbody>
</table>

*Note: Save, Rollback, then Exit releases the lock.*

**Query Menu**

The *Query Menu* contains the functions used to search for information in the database based on specific criteria.

<table>
<thead>
<tr>
<th>Option</th>
<th>Toolbar Icon</th>
<th>Keyboard Shortcut</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter</td>
<td>⌁</td>
<td>F7</td>
<td>Puts the form into Query mode so you can enter search criteria to see information already in the database</td>
</tr>
<tr>
<td>Execute</td>
<td>⌋</td>
<td>F8</td>
<td>Searches the database and displays records that match your search criteria</td>
</tr>
<tr>
<td>Last Criteria</td>
<td></td>
<td>F7 twice</td>
<td>Enters the criteria from your last search (enabled only when you are in Query Mode)</td>
</tr>
<tr>
<td>Cancel</td>
<td>❌</td>
<td>Ctrl-Q</td>
<td>Cancels the Query and takes the form out of Query Mode</td>
</tr>
<tr>
<td>Count Hits</td>
<td></td>
<td></td>
<td>Counts the number of records that match the search criteria and displays that number on the Auto Hint Line</td>
</tr>
<tr>
<td>Fetch Next Set</td>
<td></td>
<td></td>
<td>If more records meet the search criteria that fit in the window, clicking this option replaces the current set of displayed records with the next set.</td>
</tr>
</tbody>
</table>
# Quick Reference Guide to Banner Keyboard Commands

<table>
<thead>
<tr>
<th>Function</th>
<th>Toolbar Icon</th>
<th>Menu Option</th>
<th>Keyboard</th>
</tr>
</thead>
<tbody>
<tr>
<td>Next Record</td>
<td><img src="image" alt="icon" /></td>
<td>Record/Next</td>
<td>↓</td>
</tr>
<tr>
<td>Previous Record</td>
<td><img src="image" alt="icon" /></td>
<td>Record/Previous</td>
<td>↑</td>
</tr>
<tr>
<td>Delete Record</td>
<td><img src="image" alt="icon" /></td>
<td>Record/Remove</td>
<td>Shift+[F6]</td>
</tr>
<tr>
<td>Insert Record</td>
<td><img src="image" alt="icon" /></td>
<td>Record/Insert</td>
<td>[F6]</td>
</tr>
<tr>
<td>Next Block</td>
<td><img src="image" alt="icon" /></td>
<td>Block/Next</td>
<td>Ctrl+Page Down</td>
</tr>
<tr>
<td>Previous Block</td>
<td><img src="image" alt="icon" /></td>
<td>Block/Previous</td>
<td>Ctrl+Page Up</td>
</tr>
<tr>
<td>Enter Query</td>
<td><img src="image" alt="icon" /></td>
<td>Query/Enter</td>
<td>[F7]</td>
</tr>
<tr>
<td>Execute Query</td>
<td><img src="image" alt="icon" /></td>
<td>Query/Execute</td>
<td>[F8]</td>
</tr>
<tr>
<td>Cancel Query</td>
<td><img src="image" alt="icon" /></td>
<td>Query/Cancel</td>
<td>Ctrl+Q</td>
</tr>
<tr>
<td>Rollback</td>
<td><img src="image" alt="icon" /></td>
<td>File/Rollback</td>
<td>Shift+[F7]</td>
</tr>
<tr>
<td>Save (Commit)</td>
<td><img src="image" alt="icon" /></td>
<td>File/Save</td>
<td>[F10]</td>
</tr>
<tr>
<td>Next Field</td>
<td><img src="image" alt="icon" /></td>
<td>Item/Next</td>
<td>Tab</td>
</tr>
<tr>
<td>Previous Field</td>
<td><img src="image" alt="icon" /></td>
<td>Item/Previous</td>
<td>Shift+Tab</td>
</tr>
<tr>
<td>Exit</td>
<td><img src="image" alt="icon" /></td>
<td>File/Exit</td>
<td>Ctrl+Q</td>
</tr>
</tbody>
</table>